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Abstract: 

The video editing system AG-A800 facilitates editing video tapes with raw material on them. 

lt handles the video machines operations, operations as simpleas play, stop, rewind and wind and 

more advanced as marking events (certain tape position ), creating a script (number of successive 

events) and previewing and recording of these scripts on a target tape. 

The purpose of this project is to replace the standard control panel used to operate the video recorder 

editing system, by a computer. 

The computer is able to operate all the functions available at the control panel and add to that the 

further advantages of a computer supported user interface. 

Examples of these extra possibilities are : 

• Simplicity of use, with the help of windows, dialog boxes and menus. 

• Easier editing of events and video sequences. 

• Possibility of adding notes and comments tothese events and sequences. 

• Saving and retrieving sequences tor further use and editing. 

An interface between the controller and the computer was designed and the protoeals that are 

applied between the control panel and the controller were detected and documented. 

This report is the description of the software that was written for this compyter supported user 

interface, enabling the operation of simple tasks requiered for editing and recording of scripts. 

lt also includes the User's manual. 
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Introduetion 

The video editing system AG-ABOO facilitates editing video tapes with raw material on them. 

lt handles the standard video machines operations, operations as simpleas play, stop, rewind and 

wind and more advanced as marking events (certain tape position ), creating a script (number of 

successive events) , Previewing and recording of these scripts on a target tape. 

The purpose of this project is to replace the control panel used to operate the controller, by a 

computer. 

The computer is able to operate all the functions available by the control panel and add to that all the 

advantages of having a computer . 

Fig (1) shows the system contiguration that was used in this project. 

The extra hardware interface taht was needed, buffers the two inputs from the control panel and the 

computer to the controller, allowing bothof them to operate with the controller independently. 

* The hardware schematics of the interface can be found in Appendix (B). 

The protocols that are interchanged between the control panel and the controller were analysed and 

document ed. 

• The listing of the protocols can be found in the report "Videorecorder besturings -protocolen en hun 

gebruik" (reference 1 ). 

Th is report contains the description of the software written by the authur to implament the following 

functions : 

1. Goto event 

2. Goto scene start 

3. Goto scene end 

4. Goto ... 

5. Preview script 

6. Record script 

and it also contains the algorithms used and the information flow charts applied. lt ends with 

conclusions and recommendations. 

The software was programmed using MPW Pascal (Macintosh Programmer's Workshop), some 

Extender routines we re used as well as some already written IPO routines. 

Windows,dialogboxes and menus we re developed with the help of Res Edit 2.0. 

writing the documentation as well as this report, WordPerfect and Claris Cad were used. 
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Figure (1): The system with 2 videorecorders, the control panelandan aditional 
user interface computer with related interface box 
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The termlnology: 

These are words that I will use throughout the report: 

PLAYER : The video machine that is used as a source. 

RECORDER : The video machine that is used as a target. 

EVENT : A time stamp that is used to mark a certain position on the tape (unless otherwise 

clearly stated). 

SCENE 

SCRIPT 

COMMAND 

: A period of time marked by a start and end events. 

:A sequence of scenes. 

: A byte string send to the controller using the protocol in appendix 1 of report 

"Videorecorder besturings -protocol en en hun gebruik " (reference 1) 

TC : The time code mode that is recorded on the audio chanell of th tape, te is from 0 to 

24 hours and has a fixed refrence i.e. canot bereset in the middle of the tape. 

CTL :A relative time code, it can bereset to 0 at any position of the tape, soit can have 

positive or negative values depending on the position it was reset to 0 . 
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1 Program overview 

The video program is divided into 8 units :1 

*The VideoOefs Unit: 

This Unit contains all the constants, type definitions and global variables that are used in the 

program and the other units. 

*The ControlDriver Unit: 

Th is unit is the implementation of all the protocols,i.e the command lines that the computer 

sends to the controller. 

Since the computer is replacing the control panel, the protoeels that the control panel sends 

to the controller were used. 

A listing of the protoeels that were used could be found in report "Videorecorder besturings 

-protocolen en hun gebruik " (reference 1) 

*The Numerical Unit : 

This unit has all the procedures and functions that do the conversionsof one type to the 

other and other numerical functions: 

*Time conversions (string-- longint -- hours: minuets :seconds:frames --BCD). 

• Events count and Scenes count. 

*The File_Handllng Unit : 

This unit has the procedures for dealing with files : 

*Save file,Load file, Close Dbase and FileHandling Procedures. 

*The DataHandllng Unit 

This unit deals with the data for both events and scenes: 

*lnsertion,Removal and throwingout. 

*Marking and Unmarking (i.e Choosing,Hilighting) 

*The Wlndows_Events and Windowsinterface Units : 

4 

These two units deal with the windows used in the program and with OS events. 

Events here are mean mouse clicking,scrollbar movement,button etc. 

1The interface part of all the unitscan be found in Appendix (A) 



•rhe VIdeoMenu Unit : 

This unn has all the procedures and functions that are used for implementation of the 

functions on the nem Video on the top bar menu and they are: 

1. Goto event 

2. Goto scene start 

3. Goto scene end 

4. Goto ... 

5. Preview script 

6. Record script 

The functions and procedures of this unit are explained in detail in Chapter (2). 
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2 The video menu unit 

This is a description of the functions available in the video menu : 

Show controls XS 
Preuiew script XP 
Record script XR 

Goto euent 
Goto scene start 
Goto scene end 
Goto... XG 

Figure (2) The Video menu 

2.1 Goto event : 

I Reads the events time codes from the events editor window or the opened file 

I I Detects H there is a highlighted event, H not an error message appear and operation 

terminated. 

III lf there is a highlightedevent: 

Reads the current time of the player 

Gompare it to the event time 

H larger then Forward el se Backward 

H the dHference is larger then the search maximum switch to Fast Forward or 

Rewind 

else send the time code to controller using the protocol in appendix 3 of report 

"Videorecorder besturings -protocolen en hun gebruik " (reference 1) 

* Flowchart no. 1 Appendix (C). 

2.2 Goto scene start : 

6 

I Reads scenes data from the scenes editor window or the opened scenes file. 

II Detects if there is a highlighted scene, H not an error message appear and operation 

terminated. 

III lf there is a highlighted scene it executes goto event(with start time as parameter). 

* Flowchart no. 2 Appendix (C). 



2.3 Goto scene end : 

I Reads scenes data from the scenes editor window or the opened scenes file. 

II Detects if there is a highlighted scene, if not an error message appear and operatien 

terminated. 

III lf there is a highlighted scene it executes goto event (with end time as parameter). 

* Flowchart no. 3 Appendix (C). 

2.4 Goto ... 

I Displays a dialog box for event time entering 

II Reads and varifies entered time, if invalid an error message appear. 

Detects if TC or CTL mode is Required. 

Detects if Player or Recorder is adresseded. 

I II Reads the current tape time code of the Player or Recorder, 

Compares it to the event time. 

if larger then Forward else Backward 

if the ditterenee is larger then the search maximum, switch to Fast Forward or Fast 

Rewind 

else send the time code to controller using the protocol in appendix 3 of reference1 

2.5 Preview script : 

Previewing a script is playing the selected scenes in there specified order before recording 

the script. 

There are two ways to preview a script : 

I Computer Controlled : 

(a). Each scene is read from the script editor or the open file. 

A Goto Event call is issued with scene start time as a parameter. 

A Play command is issued. 

The Player time is monitored until it reaches the scene end time. 

The following scenes are previewed in the same manner until end of script. 

* Flowchart no. 4 Appendix (C). 

(b). Each scene is read from the script editor or the open file. 
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The scene start is marked in and the scene end is marked out. 

A Preview Command is issued. 

The oparation is monitored by, the procedure reads the time code of the player until it 

is less than the start event time ( prerol ) and then reads the time code again until it is 

higher than the endevent time, this indicates the end of previewing the scene. 

The following scenes are handled the same way until end of script. 

• Flowchart no. 5 Appendix (C). 

I I Controller Function : 

This method can bedescribed as follows: 

*Event numbers are selected using the protocol in appendix 5 of 

report "Videorecorder besturings -protocolen en hun gebruik " (reference 1 ). 

*Each scene is marked (i.e. the scene start is rnarked in and the scene end is 

marked out). 

*Auto Preview Mode is selected. 

• Flowchart no. 6 Appendix (C). 

**This was not compieled because the protocol for event number setting was not functioning 

2.6 Record Script : 

8 

There are two ways to preview a script : 

I Computer Controlled : 

Recorder is selected. 

Recorder time is read and this time is marked in as the recorder entry point, thus the 

recorder has to be set to the entry point manually before recording the script. 

Player is selected. 

Each scene is read trom the script editor or the open file. 

The scene start is marked in and the scene end is marked out. 

An Edit command is issued. 

The oparation is monitored by, the procedure reads the time code of the player until 

its value is Ie ss than the start event time ( prerol ) and then reads the time code again 

until it is higher than the endevent time, this indicates the end of previewing the 

scene. 

The following scenes are recorded in the same manner until end of script. 

• Flowchart no. 7 Appendix (C). 



I I Controller Eu netjon : 

This method can bedescribed as fellows: 

*The current position of the recorder is marked in as an entry point. 

*Event numbers are selected using the protocol in appendix 5 of 

report "Videorecorder besturings -protocolen en hun gebruik" (reference1). 

*Each scenes is marked (i.e the scene start is marked in and the scene end is 

marked out). 

• Auto Edit Mode is select ed. 

• Flowchart no. 8 Appendix (C). 

**This was not completed because the protocol for event number setting was not functioning. 
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The User's Manual 

About the video control software 

The user's manual describes the operations and functions of the video control software. 

This manual assumes that you have already rnastared the basics of your Macintosh, if not you are 

advised to refer to your Macintosh System Software User's Guide. 

Readers are recommended to read Chapter 1 " Befare you start " first. 
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1 Before you start 

1...1 Start up 

The video control software needs a eertsin configuration to operate, this chapter describes this 

configuration, connections and setting the system for proper operation. 

A ) The basic system : 

The following units are needed : 

1. Your Macintosh llfx. 

2. The AG-ASOO 1/F unitand the control panel (optional ). 

3. TwoVTRs. 

4. Your Video Besturings Interface. 

B ) Conneetiens : 

*For the conneetion of the AG-ASOO unit with two VTRs refer to the oparating manual of the 

Editing Controller (reference 2). 

12 

* Conneetion of the computer interface : 

•••••••• 
••••••• 

The Interface 

00000000 

0000000 

15 pin connector male 
to CONTROLLER 

1/F unit 

9 pin connector male 
to COMPUTER 

••••• 
•••• 

15 pin connector female 
to CONTROL PANEL 

Figure (3) The interface conneetion and connectors 



1...2. What Is In the video control software Package 

1. A 3 112 " Program disk. 

2. The interface unit. 

3. One 9 pin connector cable. 

4. This manual. 

U On vour Program disk : 

1. Video :The video control software's main body. 

2. Demo : A Demonstratien script. 

That's all you need to operate your software. 
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2 Menus 

Tostart up your application the file Video on your program disk is opened. 

( Double click on Video icon Fig (4) ). 

'v'ideo 

Figure(4) the Video icon 

Upon start up the Video Besturings logo appears on the screen Fig(5), upon clicking into the picture 

or pressing enter, it disappears. 

~ .. 
; .. 
; 
• 

~ .. 
; .. 
; 
• 

Video 
Control 

Software 

Copyright: 
lnstitute tor Perception research 

Figure (5) video control software logo 

2.1 The top bar menu : 

The top bar menu has four items : 

File Edit VIdeo and Extra Fig (6). 

I é File Edit Uideo EHtra 

Figure (6) The top bar menu 

Each of these menus is explained with the functionality of each item on it. 
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2.2 The File menu : 

New XN 
New script 
Open XO 
Open script 

Close XW 
Saue 
Saue as 

Get info X I 
Quit XQ 

Figure (7 ) The File Menu 

lts functions are : 

2.2.1- New: 

Ibis Item is used to open a new events file, by choosing this item the event editor window in Fig (8) is 

displayed on the screen and the new file is given the name Untltled . 

After opening a new fileor after opening an old file (using item Open ), this item will be disabled until 

the ciosure of the active file. 

-o ~ untiteled 

~ Event Editor 

tijcb:rle El..e'\ t des:cr i p ti a'l 

Figure (8) The Event Editor window 
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2.2.2 - New script : 

To create a script tromtheevents Chosen, this item opens a new script file,and displays the script 

Editor window Fig (9} on the screen,the same as New, it gives the newly opened script the name 

Untltled. 

Th is item can not be chosen unless there is an event file open i.e the Event Editor window is open, 

otherwise this item will be disabled. 

0 Untiteled 

Script Editor 

tijdeode Scene deseription 

I 
0 

Figure (9} The Script Editor window 

2.2.3 - Open : 

You can u se this item to open a file that was created earlier, a window in Fig (1 0} is opened, you can 

use the scrollbars to locate the file you want to openor type in the name of the file. 

after you have located your file you can click the button Open to open the fileor the button Cancel 

to return to the program without opening a file. 

Upon execution, i.e if you click Open, the Event Editor window is displayed with the data trom the file 

printed in it. 

16 



je=~ Caesar I 
D geert 
D Hypercard 1.2.5 
D MPW3.0 
D mysys 
CJ newsystem89 
CJ Public 
D System Folder 
Cl Utilities 
CJ word 

Figure (1 0) The Open window 

2.2.4 - Open script : 

c=~ Caesar 

( ) 

( ) 

( Open ) 

[ Cancel ) 

With the Event Editor window open the Open script item opens the script file related to the event 

file (ex. if you have a script that was created before, it will have two parts, the Events and the scenes 

"script") . 

Also the Script Editor window is displayed with the script data printed in it. 

This item is available only when theEvent Editor is Active. 

2.2.5 - Close : 

The Close Item closes the active file, it saves the events and the script and closes the event editor and 

the script editor windows if they are open. 

Upon ciosure the file is saved to the disk and there are two cases : 

a) lf the file was already on the disk and was opened using the Open item from the File 

menu, the file is saved with the changes made. 

Cautlon : The file is saved with the changes without asking the user for a confirmation. 

b) lf the file was a new file, the window in Fig (11) is displayed and the user is asked to choose 

the name and the place tor the file too be saved, aft er entering the new name you can click 

the button save to confirm and save the fileor click the button Cancel to return to the 

editor. 

lf you choose a file name that already exists a the window in Fig (12) is displayed, the default is 

No, so if you click the button Noorpressenter it goesback toreenter the name. 

17 



lc:J Caesar I 
CJ mysys 
CJ newsystemfi9 
CJ Public 
CJ System Folder 
CJ Utilities 
CJ word 

Saue current list as .. 

jlimnnm ---·::._--:=--~-- ~--~±-.:. 

Figure (11) The Save file window 

c=~ Caesar 

( l:jt~e1 ) 
( [hht(~ ) 

( Saue ) 

( Cancel ) 

lf you click on Yes the old file with the samename will be replaced by this one. 

Cautlon : The data of the old file with same name will be lost in case of clicking Yes. 

Replate eHisting 
"Untitled" ? 

[~ __ Y_es __ ~) n~---N-o._~» 

Figure (12) confirm save with an existing name 

2.2.6 - Save : 

You can save the script file any time by choosing this item. 

lf the file was a new file, the window in Fig (11) is displayed and the user is asked to choose the name 

and the place for the file too be saved, after entering the new name you can cl.ick the button save to 

confirm and save the fileor click the button Cancel to return to the editor. 

lf you choose a file name that already exists a the window in Fig (12) is displayed, the defau~ is 

No, so if you click the button Noorpressenter it goesback toreenter the name. 

2.2.7- Save as : 

lt operatas exactly like Save the only difference between them that Save as is usually used to save a 

certain script with a different name than its original one. 

This is used tor backup files and tor renaming script files. 

18 



2.2.8- Get Info : 

This item is used to get information about the data base you are working on i.e the script, it gives you 

the number of events that have been grabbed and the number of scenes that we re created, it also 

gives the number of events and scenes in the clipboard Fig (13). 

*"'"' UIDEO DATABASE **"' 
INFOAMATI ON 

Number of euents = 00 

Number of scenes = 00 

Euents in clip = 00 

Scenes in clip = 00 

( OK J 

Figure (13) Get Info winclow 

2.2.9 - Cult : 

Cult is used to terminate (i.e abort ) the program. 

In case there is an open file it acts exactly like Close in the way it saves the file, otherwise it just exits 

the program and return control to the outer shell (usually the eperating system). 
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2.3 The Edit Menu : 

The Edit menu has all the operations related to data editing like cut and copy to clipboard and paste 

from clipboard and finally select all. 

Cut XH 
Copy »CC 
Paste XU 

Select all 

Figure (14) The Edit menu 

2.3.1 -Cut: 

Cut removes the hilighted data from the window and puts it temporarily in the clipboard, in case there 

is no hilighted data Cut bas no operation. 

2.3.2 - Copy : 

Copy Copies the hilighted data to the clipboard without removing the original data from the window. 

Copy has a very important eperation in creating scenes from theevents available, this operatien is 

explained in detail in chapter (3) under " Adding scenes to script ". 

2.3.3 - Paste : 

Paste is used to retrieve data from the clipboard and place in your place of choice. 

2.3.4 - Select all : 

lt is used to select all the data in a window and it is used usually to clear all data on a window or to copy 

or cut theses data to the clipboard for later pasting in another window or application. 

20 



2.4 Ihe VIdeo menu : 

The Video menu bas all the functions that deals with the Video controller, starting from the simple 

operations like Play, Stop, Search, Wind and Rewind, to the complicated ones like goto functions, 

Preview and Record scripts. 

2.4.1. Show controts : 

Show controls XS 
Preuiew script XP 
Record script XR 

Goto euent 
Goto scene start 
Goto scene end 
Goto... XG 

Figure (15) The VIdeo menu 

When this item is chosen the window in Fig (16) appears. 

Player Status O~IDEO CONTROL RIINDOHI 

Player 
. 

still. lS 

nctions keys 
{ ( Play ) ( Wind ) 8 ( Stop ) ( Rewind) 

Player fu 

layer time code I<:J I i tit i ti tititi[i[i[i[i[iti[iji[l l!i[i[i\i[i[i[i[itililililililil 0{ oo I i i I I I 

" rder Status I 00:00:00:00 I 

p 

Reco 

" Recorder 
. 

still. lS 

r tunetion keys { ( Pley ) ( Wind ) 
( Stop ) ( Rewind) (Record ) 

Reeorde 

ecorder time code I<:J H~l~=i:~=~H?~=ii+l1HHI rrrnnnr····1 Of I :i;i;ni;i;i;i;i;i;i;i;i;m<: oo :::::::::=:·:·:i:::::::::,:::;. 
I r r 

' I 00:00:00:00 I 

R 

Figure (16) The Video Control Window 

Grab an event butt on 

Player Speed indic a tor 

Recorder speed c ontrol 
scrollbar 

Recorder speed in dicator 

Player speed con trol 
scrollbar 
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The running speed of the tapescan be controlled by the scrollbars, there are various running 

speeds for the tapes and they are displayed on the right of each scrollbar in percent %, 

rafereneed to the normal running speed. 

where: 

0% : forStop 

600% : max search speed 

Possible speeds are : 

0 7 12 25 

1 00% : for normal play speed 

1000% : wind and rewind speeds 

50 1 00 200 600 1000 

2.4.2. Goto... : 

22 

Goto ... is used to position the player or the recorder tapes on a certain position that has the 

time code entered. 

lf the difference between the tape's current position and the target position is more than 30 

seconds, the VTR is switched to Fast Forward or Rewind ( depending on the relation 

between the two positions ). 

When this option is chosen the window in Fig. (17) appears. 

Using this window Recorder or player could be chosen for the goto oparation 

also the time code can be selected TC or CTL, 

The time should be entered in the format 

sign (i.e + or -) HH:MM:SS:FF 

Where: 

HH : Hours (0 to 23). 

MM : Minutes (0 to 59). 

SS : Seconds (0 to 59). 

FF : Frames (0 to 23). 

The default button is the Goto button, so it also operatas if the enter Key was pressed. 

lf the entered time format is wrong and an the error massage in Fig (18) appears. 



Enter Euent Time 
'SignHH:MM:SS:FF' 

Time Mode 

@TC 

QCTL 

GOTO EUENT 

( Cancel ) 

Deuice 

® Player 

0 Record 

Figure (17) Goto •.• Dialog box 

Time FORMAT Error : 
SignHH:MM:SS.FF 

ReEnter 

I 

([ OK )) I 

I 
Figure (18) Time format error message 

2.4.3- Goto scene start 

To choose this option a scene from the script editor should be highlighted i.e. chosen, other wise an 

error massage will appear . 

When a scene is chosen the window in Fig (19) appears, it is used to confirm or cancel the goto scene 

start function. 

23 



Goto Scene Stort 

Tl ME : 00:00:01.00 

( CRNCEL ) n GOTO ~ 

Figure (19) goto scene start window 

2.4.4- Goto scene end : 

this option operates exactly as goto scene start, Fig (20). 

Goto Scene End 

Tl ME : 00:00:1 0.00 

( CRNCEL ) u GOTO ll 

Figure (20) goto scene end window 

2.4.5 - Preview script : 

Preview the script, allows you topreview the scenes in there sequence, befere the reai editing is 

done, the Preview eperation simulates exactly theedit operatien (record), meaning it places the 

positions of the tapes at 1 0 seconds befere the entry point ( prerol time ) and then locks the two 

motors of the player and the recorder together, you can he ar a click when the VTRs reach the entry 

point and another click when they reach the out point. 

of course to choose this option, you have to have a script open in the script editor, otherwise no 

Preview has no action. 

A status window is displayed on the screen Fig (21),and you can stop Previewing by clicking the Stop 

button in that window. 

In case an error occurs an error message is displayed with the scene number that it was stopped at 

printed in it. 
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Player rewind 

Figure (21) Status window 

2.4.6 - Record script : 

This is the final stage in the program, after collecting events, creating the script's scenes and 

previewing the script, you choose the item record script to record the scenes in there sequence to 

the target tape. 

Similar to Preview,record script needs an open script file in the script editor and it also displays a status 

window that has a Stop button in case you want to terminate the recording operation. 

2.5 The Extra menu : 

The Extra menu has one item on it lnsert timecode Fig(22), the oparation of this item will be 

explained in detail in chapter (3) under the title "Adding scenes to script" 

I nsert timecode 

Figure (22) The Extra menu 
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3 Creatlng a script 

The script file has two main components : 

The Events : which are the tape positions that you chose to Grab. 

The Script: Which is a sequence of scenes (i.e. pairs of events mark every scene startand 

end). 

3.1 Collectlng Eyents : 

*The events are collected by running the tape in the Play mode and grabbing the points of interest, 

that will be used later to create the script. 

*Ciicking the Grab Button in the VIdeo Control Wlndow or the Event Editor Wlndow, The 

time code of the position of the tape that you grabbed will be displayed on the left column of the 

Event Editor's Window. 

*The events that are grabbed are sorted in the event editor in an ascending order by there time 

codes. 

*To write a description or a comment to that event Double Click in the right column of the Event 

Editor's Window, justin front of theevent You want to comment on. 

The Change Event comment window in Fig (23) will Appear. 

Event occured at 00:00:05.15 ! 
Commentsize maximum 2 lines of 50 eh. 

jl 

( Concel ) ( Ok ) 

Figure (23) Change Event Comment Window 

Enter the comment, then click on Ok to confirm or Cancel to return without change. 

lf you click Ok the oomment you entered will be displayed in the left column, to change it again or to 

edit a part of it double click on it, you will go back to Change Event oomment window again, correct the 

comment and press Ok. 

26 



3.2 Addlng Scenes to The Script : 

Every scene needs two events, start and end event and of course the value of the start event time 

code should be earlier than the end time code. 

To add a scene : 

1- Make the Event Editor Window active i.e click anywhere in the window if the event editor 

was on screen, else open an event file using New or Open from the File menu "refer to 

chapter 2 section 2.2". 

2- Use the serallbars tolook for theevents that will markthestart and of your scene. 

3- Choose the start event, by hilighting it's time code (i.e double click on the time code part of 

the event). 

4- To choose the end scene click on the time code of the end event WHILE PRESSING THE 

SHIFT KEY. 

now both the start and end events are hilighted. 

5- From theEdit menu choose the Copy option, the two events will be copied to clipboard. 

6- Make the Script Editor Window active by clicking any where in the winc:low if the Window is 

on the screen, else open a script file using the New script or Open script from the File 

menu " refer to Chapter 2 sec 2.2 ". 

7- From the Extra menu choose lnsert Time Code, the scene wiJl be added and 

displayed at the end, i.e the last scene in the script editor. 

lf you want the scene to be inserted before another scene, before you execute step 7 hilight 

the scene in the script editor that you want to insert your new scene before it, ( hilighting is 

done by double clicking on the time code of the scene), then choose lnsert time code 

trom the Extra menu . 

8- To write a description or a camment to that Scene, Double Click in the right column of the 

Script Editor's Window , Just in front of the scene You want to camment on. 

The Change Scene comment window in Fig (24) will appear. 
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Change Scene Comment: 
scene starts at 00:00:01.00 and ends at 

00:00:10.00 ! 
Commentsize maxi~um 4 lines of 50 eh. 

( Cancel ) ( Olc ) 

Figure (24) Change Scene Gomment window 

Enter the comment, then click on Ok to confirm or Cancel to return without change. 

lf you click Ok the comment you entered will be displayed in the rlght column, to change it 

again or to edit a part of it double click on it, you will go back to Change Event comment 

window again, correct the comment and press Ok. 

The default comment will be the concatenation of the starand end event comments . 



4 Conclusjons and recomendations 

* An error occurs due to damages on the video tape, this eausas operations like Preview and Record 

to stop, a way of dateetion I tried was to read the time code and save it in a temporary storage, if after 

ten successive readings the time code is still the same the program assumes that the oparation has 

stoppad and displays an error massage. 

* In the controller manual and on the control panel the word EVENT is used instead of the word 

SCENE that is used throughout this report. 

* For Avoiding linking errors (Calls and jumps out of range), the program was divided into segments, 

each unit in a separate segment. 

The $8 Directive was used for that purpose. see MPW 3.0 compiler directives. 

* I used {$ I XtendFast.p} for including the interface part of this souree file, it is necessary to do that for 

using some of the EXTENDER's Procedures. 

(ex. FrameDitem) 

* The Mark (IN_ OUT) procedure had to be called twice to insure proper execution, further study of the 

reason for that is needed. 

*Time delays of 1/3 of a second are used to separate any two consecutive commands to the 

controller. 

The delay was implemented using the tickhandier which facilitates delaysto the accuracy of 1/60 of a 

second. 

(This delay is included in procedure command using procedure delayer) 

* For editing, the entry point for the recorder (i.e Mark in ) is marked tor every scene and it is the 

position of the recorder tape in the end of the previous scene. 

The Controller actually does that automatically, soit is recommended to change that procedure. 

* In the program most of the settings are fixed, although they could be changed using the protoeels 

available, for example : The prerol time (10). the time mode (TC), REC mode and (insert V) mode for 

editing. 

* When a new file is opened and then closed, the save oparation can not be bypassed, this needs to 

be changed (i.e the possibility that you don't want to save the file ). 
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• An initial edit oparation should be implemented for video tapes used for the first time and do not 

have time code on them. 

• Time code recording on the target tape should be linearand trom the same souree otherwise errors 

occur executing Goto, Preview and Edit procedures , tor example if the time code is being recorder 

trom the souree tape and we have two successive scenes in this format : 

scene 1 : trom 00:02:00:00 to 00:03:00:00 

scene 2 : trom 00:04:00:00 to 00:05:00:00 

the target tape will have a non continuous time code, which results in search errors,(the tape is going 

back and forth looking for time code 00:03:30:00 tor example as there is two consecutive points with 

codes 00:03:00:00 and 00:04:00:00) 

• For lnsert editing ( i.e adding program material somewhere in the middle of a previously recorded 

portion ) A Script editor is needed tor the recorderevents to be grabbed and antered as scenes, the 

same protocol tor marking events that is used tor the player can be used tor the recorder with a 

change in the address used. 

• For the scene by scene recording, a tunetion can be added to the program to calculate the startand 

end time of the recorder, this decrease the confusion that the time codes of the player are the ones 

that are used to mark the scenes, instead we can have each scene marked by both : the portion to be 

recorded trom the player and the exact location of that portion on the recorder tape. 

• A better interface tor connecting the computer to the controller is recomended. 

The interface available now does not tunetion properly if the control panel is not connected . 
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1, UNIT Cotnrotortver 

PROCEDURE SetUplink; 

PROCEDURE Closelink; 

Appendix (A) 

!he units Interfaces 

PROCEDURE SendByteString ( KO,K1 ,K2,K3,K4,K5,K6,K7 :Integer); 

PROCEDURE SendTimeCode ( Frames, Sec, Min, Uren : Integer); 

PROCEDURE lees_tijdcode ( var tijdcode_p : Longint ; var tijdcode_r : Longint ) ; 

PROCEDURE Mark ( IN_ OUT : Integer; u,m,s,f : Integer); 

PROCEDURE SetEventNo ( EventNo: Integer); 

2, UNIT NUMERICAL 

FUNGIION EventCount ( Whichlist : Event_Handle ) : Integer; 

FUNGIION SceneCount ( Whichlist : Scene_Handle ) : Integer; 

FUNGIION lsGoedeTijdcode (te : String ) : Boolean; 

FUNGIION IntToString ( nummer : Integer) : String11; 

PROCEDURE Delayer ( Period: Integer); 

PROCEDURE TimeToString ( t: lntegerteller; VAR s: String11 ); 

PROCEDURE StringToTime( TimeCode : String11 ; Var u,m,s,f : lnteger;var 

Timelong : Longint); 

PROCEDURE TimeToLong ( TimeArr : ReeksType; var TimeCode_p : Longint; var 

TimeCode_r: Longint ); 

PROCEDURE LongToBCD (Code: Longint; var f,s,m,h: Integer); 

PROCEDURE LongToTime (x: Longint; VAR t: Integerteller ); 

3 UNIT FILESHANPLING 

PROCEDURE Load_file (VAR EV: EventWindow; VAR SC: ScriptWindow; FileName: 

filenaam_lengte; VAR Error: Boolean ); 

PROCEDURE Save_file ( EV: EventWindow; SC: ScriptWindow; FileName: filenaam_lengte; VAR 

GingDoor: Boolean); 

PROCEDURE CloseDbase (VAR EV: EventWindow; VAR SC: ScriptWindow ); 

PROCEDURE FileHandling; 
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4. UNIT DATAHANDLING 

FUNGIION ThrowOutEvent ( VAR Whichlist : Event_Handle; VAR eve : Event_record ) : Boolean; 

FUNGIION ThrowOutScene (VAR Whichlist: Scene_Handle; VAR sce: Script_record): Boolean; 

PROCEDURE ToggleMarkEvents ( Whichlist: Event_Handle; value: Boolean ); 

PROCEDURE ToggleMarkScenes ( Whichlist: Scene_Handle; value: Boolean ); 

PROCEDURE lnsertEvent (VAR Whichlist: Event_Handle; tijdcode: String11; Commentaar: 

String100; Check: Boolean) ; 

PROCEDURE lnsertScene (VAR Whichlist: Scene_Handle; start.Einde : String11; Commentaar: 

String200 ) ; 

PROCEDURE lnsertTimecodes (VAR EV: EventWindow; VAR SC: ScriptWindow ); 

PROCEDURE RemoveEvents (VAR Whichlist: Event_Handle ); 

PROCEDURE RemcveScenes ( VAR Whichlist : Scene_Handle ) ; 

PROCEDURE KiiiFirstEvent (Hand: Event_Handle ); 

PROCEDURE RemoveDbase (VAR EV: EventWindow; VAR SC: ScriptWindow); 

5. UNIT WINDOWS EyentS 

FUNGIION rs ( id : integer) : str255; 

FUNGIION OKwarning ( p0,p1,p2,p3 : str255 ) : Boolean; 

FUNGIION Rectangle ( lett,top,right,bottom : Integer ) : reet; 

FUNGIION IsMenultem ( WhatHappened : EventStuff; MNum,INum : Integer) : Boolean; 

FUNGIION lsButton ( WhatHappened: EventStuff; but : ControlHandle) : Boolean; 

FUNGIION lsScroiiBar ( WhatHappened: EventStuff; scroll: ControlHandle) : Boolean; 

FUNGIION lsScroiiValue ( WhatHappened : EventStuff; scroll : ControiHandle; v: Integer) : Boolean; 

FUNGIION ShiftPressed ( scene : EventRecord ) : Boolean; 

PROCEDURE Error ( M1,M2,M3 : Str255 ); 

PROCEDURE TimeError ( OldTime,NewTime: Longint; Var Counter:lnteger ); 

PROCEDURE FileNaarnis (naam : filenaam_lengte ); 

PROCEDURE DoneWithEvent ( var WhatHappened : EventStuff ) ; 

PROCEDURE PlayASound (st : Str255 ) ; 

PROCEDURE warning ( pO,p1,p2,p3 : str255) ; 

PROCEDURE PrintChar ( C : char;x,y,maxy : Integer) ; 

PROCEDURE fout_melding; 

PROCEDURE fout_melding2; 

PROCEDURE install_menus; 
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PROCEDURE SwitchPiayer (VAR EV: EventWindow;VAR VI :VideoWindow;play,stop,wind,rewind

,grab,scroll : Integer ) ; 

PROCEDURE SwitchRecorder (VAR VI: VideoWindow;play,stop,wind,rewind,recrd,scroll: Integer) ; 

PROCEDURE SwitchFile ( lnew,lnews,lopen,lopens,ICiose,lsave,lsaveas,lquit: Integer) ; 

PROCEDURE SwitchEdit ( value,select : Integer) ; 

PROCEDURE SwitchVideo ( lcon,lplay,lrec,leve,lst,len,lgo :Integer) ; 

PROCEDURE SwitchExtra ( insert : Integer) ; 

6, UNIT WINPOWSINTERFACE 

FUNCTION TranslateScroll ( v : Integer) : Integer; {independent} 

PROCEDURE Video_controls ( VAR VI : VideoWindow ) ; 

PROCEDURE Event_controls ( VAR EV : EventWindow) ; 

PROCEDURE Script_controls ( VAR SC : ScriptWindow) ; 

PROCEDURE TrieToPrintCounters ( video : lnteger;var tijdcode : Longint ) ; 

PROCEDURE TrieToPrintSpeed ( video : Integer) ; 

PROCEDURE TrieToPrintMode ( video,mode : Integer) ; 

PROCEDURE PrintEvents (VAR EV: EventWindow); 

PROCEDURE PrintScenes (VAR SC: ScriptWindow ); 

PROCEDURE Event_graphics ( VAR EV : EventWindow ) ; 

PROCEDURE Script_graphics (VAR SC: ScriptWindow); 

PROCEDURE instaii_Windows; 

7. UNIT VIDEOMENU 

PROCEDURE PreviewScript ( ScriptWind: ScriptWindow); 

PROCEDURE RecordScript ( ScriptWind : ScriptWindow) ; 

PROCEDURE GotoScene (StartEnd : Boolean) ; 

PROCEDURE GotoTheEvent; 

PROCEDURE GotoGeneral; 
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APPENDIX (C) 
FLOWCHARTS 

Flowchart No. T1tle 

1 Goto Event 
2 Goto Scene Start 
3 Goto Scene End 
4 Preview Script Computer 
5 Preview Script Computer 
6 Preview Script Contro 11 er 
7 Record Script Computer 
8 Record Script Controller 
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Flowchart No.2 
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Flowchart No. 6 Preview Script 
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Flowchart No. 8 Record Script 
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APPENDIX (D) 
SOFTWARE LIST!NGS 

For proteetion of Copy Rights, the listing of the software souree was not allowed to be ineluded. 
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